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What’s New in This Document

New Features Documented

This revision of the IRIXconsole Administrator’s Guide documents an updated user
interface for IRISconsole.

Major Documentation Changes

Changes to this document for the IRISconsole 2.0 release include the following:

• Moves IRISconsole Preferences functionality description to the IRISconsole GUI
main window Edit menu documentation.

• Adds descriptions of the Power On and Power Off buttons to the Site window
documentation.

• Adds descriptions of the Console Logs Directory and Alarm Logs Directory fields to
the Change IRISconsole Config dialog box documentation.

• Moves partitioned system functionality description to the Change Site Config
dialog box documentation.

• Adds FailSafe Controls System Control Port functionality description to the Change
Site Config dialog box documentation.

• Adds descriptions of improved system logging functionality.

• Adds information about how Console and Remote System Controller connections
affect the operation buttons described in the performing operations on attached
systems documentation.
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About This Guide

This guide documents the IRISconsole software graphical user interface for a Silicon
Graphics OCTANE, O2, or Indy workstation that allows it to control Origin,
CHALLENGE, Onyx2, and Onyx systems. The IRISconsole software is included in the
base IRISconsole option, which includes any one of the following IRISconsole
multiplexers: ST-1600, ST-1616, ST-1620, ST-1032, EL-8, EL-16, or EL-32. Serial cables,
which are specific to the type of system controlled, are provided by additional
IRISconsole options and complete the IRISconsole package.

The OCTANE, O2, or Indy workstation communicates with the servers through the
multiplexer, to which each Origin, CHALLENGE, or Onyx system is connected via a pair
of serial cables. Each multiplexer has ports for eight or more Origin, CHALLENGE, and
Onyx systems; additional sets of serial cables are available from Silicon Graphics.
Optionally, an additional multiplexer can be connected to the workstation to monitor
additional servers.

This guide was prepared for release 2.0 of IRISconsole.

Audience

This guide is written for system administrators and service personnel who are
responsible for the configurations of two or more Origin, CHALLENGE, or Onyx
systems that the IRISconsole controls and monitors. These persons can use the
IRISconsole software to monitor the attached systems.
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About This Guide

Structure of This Document

This guide contains the following chapters and appendixes:

• Chapter 1, “IRISconsole Features and Capabilities,” introduces IRISconsole features
and describes how IRISconsole works with Origin, CHALLENGE, and Onyx
systems. This chapter explains how to use the IRISconsole security feature.

• Chapter 2, “Configuring IRISconsole,” describes how to set up IRISconsole software
in preparation for configuring and administering groups of systems.

• Chapter 3, “Configuring Sites,” explains how to use the IRISconsole graphical user
interface to set up groups of systems for administration purposes.

• Chapter 4, “Administering Sites,” explains how to use the IRISconsole graphical
user interface for administration tasks such as determining hardware status
(voltage, operating temperature, and blower speeds), and controlling, shutting
down, or restarting systems in a site.

• Appendix A, “Error Messages and Warning Messages,” lists and explains
IRISconsole error and warning messages.

An index completes this guide.

Font Conventions Used in This Guide

These font conventions are used in this guide:

Italics Executable names, filenames, IRIX commands, manual or book titles,
new terms, program variables, tools, utilities, variable command line
arguments, variable coordinates, and variables to be supplied by the
user in examples, code, and syntax statements

Fixed-width type

 Error messages, prompts, and onscreen text

Bold fixed-width type

User input, including keyboard keys (printing and nonprinting); literals
supplied by the user in examples, code, and syntax statements



1

Chapter 1

1. IRISconsole Features and Capabilities

This chapter introduces the operational features and capabilities of the IRISconsole
software. The major sections in this chapter are as follows:

• “IRISconsole Hardware Configuration” on page 1

• “IRISconsole Graphical User Interface” on page 4

• “IRISconsole Security” on page 5

• “Overview of IRISconsole Operation” on page 6

IRISconsole Hardware Configuration

The IRISconsole software allows an OCTANE, O2, or Indy workstation to control
Origin200, Origin2000, CHALLENGE, Onyx2, and Onyx systems through one to six
SCSI-based multiplexers and up to ten Ethernet-based multiplexers. The multiplexers
can be any of the following Silicon Graphics multiplexers: ST-1600, ST-1616, ST-1620,
ST-1032, EL-8, EL-16, or EL-32. Serial cables that are ordered as separate the IRISconsole
option products connect the Remote System Control port and the System Console port
on each server to the multiplexer.

IRISconsole includes a security feature that lets you specify administrators and users
who will have access to the functions of IRISconsole. Also, certain features of IRISconsole
can be accessed remotely using ictelnet, a version of telnet that works with IRISconsole.

IRISconsole is a local system; the IRISconsole software applies only to systems that are
physically attached to the multiplexer connected to the OCTANE, O2, or Indy
workstation on which the IRISconsole software is running. The IRISconsole software
cannot communicate with another system running IRISconsole to share access to
attached systems.

Cabling the multiplexer and Origin, CHALLENGE, Onyx2, and Onyx systems is
explained in the IRISconsole Multiplexer Installation Guide (007-2839-nnn), and online man
pages. Figure 1-1 shows an example IRISconsole site installation.
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Figure 1-1 IRISconsole Site Example
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Hardware requirements for the IRISconsole software are as follows:

• The 24-bit O2 or Indy workstation or OCTANE workstation must have a minimum
of 32 MB of memory and must be running IRIX 6.2, 6.3, 6.4, or 6.5. The 20-inch
display is strongly recommended for IRISconsole operation, as are XFS file systems,
for their decreased recovery time and typically better performance.

• If one of the attached servers is a CHALLENGE S, or if an attached CHALLENGE
or Onyx system does not have a Remote System Control port, not all features of the
IRISconsole software are available. An upgrade consisting of an RS-232 plate
assembly is available to equip CHALLENGE L servers that lack this port; contact
your service representative.

• Only cables ordered as IRISconsole options are supported for connecting the Origin,
CHALLENGE, Onyx2, and Onyx systems to the multiplexer. The IRISconsole
Multiplexer Installation Guide describes these cables.

IRISconsole Commands

The IRISconsole software includes the following shell commands: ic, icpass, ictelnet, and
icdbcnvrt.

ic The ic command brings up the IRISconsole graphical user interface. It is
described in the next section, “IRISconsole Graphical User Interface.”

icpass The icpass command is used for setting up and maintaining
administrator and user logins, each with a password. These logins and
passwords are specific to IRISconsole and are independent of system
logins and passwords. Using icpass, you can

• determine whether IRISconsole security is off or on

• add an IRISconsole administrator

• add an IRISconsole user

• change the administrator’s or user’s password

• delete an administrator or user

• set IRISconsole security off or on

• view a list of IRISconsole users

• allow or deny system access based on the cron command’s allow
and deny files.
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Using icpass is described in Chapter 2, “Configuring IRISconsole,” and
Chapter 4, “Administering Sites.”

ictelnet You can use the command ictelnet, which is a version of telnet adapted
for IRISconsole, to access the IRISconsole text-based menu from another
system.

Preparing the IRISconsole OCTANE, O2, or Indy system for using
ictelnet is described in the section “Setting Up IRISconsole for Remote
Access” in Chapter 2. Using ictelnet is described in the section
“Connecting to a Remote IRISconsole Workstation” in Chapter 4.

icdbcnvrt The IRISconsole 2.0 release uses a database introduced in the
IRISconsole 1.3 release to store site and system information. The
icdbcnvrt command is run by installation software to convert site and
system information from the IRISconsole 1.2 or 1.3 release to the
IRISconsole 2.0 release.

IRISconsole Graphical User Interface

The IRISconsole graphical user interface (GUI) enables you to set up and administer sites.
A site is a group of workstations, servers, or other systems that are administered through
IRISconsole.

The command that invokes the IRISconsole GUI is called ic. You can use the IRISconsole
GUI to

• set up a site or add or delete the systems in a site, get the SYSLOG files for all
systems, shut down all systems in a site, and edit alarm scripts for all systems

• display, view, or take control of the console of a system

• generate a nonmaskable interrupt (NMI), perform a hardware reset, or power cycle
a system, power on or power off a system

Note: System controllers on Origin and Onyx2 systems have passwords, which are
different from IRIX login passwords. In this release of IRISconsole, generating an
NMI, performing a hardware reset, power cycling a system, and powering on and
powering off require that system controller passwords have their default values.

• view activity logs and other system reports

• connect to the system controller on an Origin or Onyx2 system and issue system
controller commands
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• set alarms and view system performance tools throughout the site

• view real-time graphs of hardware operating statistics of a system in a site, such as
voltage, operating temperature, and blower speeds; save the graphs as files and
display them (this feature is not available on Origin, Onyx2, or other systems not
from Silicon Graphics)

• set a threshold for operating statistics so that an alarm is activated and various
activities are triggered when the threshold is exceeded (this feature is not available
on Origin and Onyx2 systems)

Chapter 3, “Configuring Sites,” and Chapter 4, “Administering Sites,” in this guide
explain how use the IRISconsole GUI to set up sites and administer sites, respectively.

IRISconsole Security

IRISconsole includes security features that use local password protection to assist
administrators in securing IRISconsole and its managed systems from unauthorized
access. When IRISconsole security is turned on (the default), access to certain operations
is controlled. Some of these operations are represented by buttons in the site window of
the IRISconsole GUI. The operations that are controlled when security is turned on are as
follows:

• adding or deleting sites and systems in the sites (Edit pulldown menu)

• getting the console (Get Console), viewing the console window of a system
controlled by another user (Spy Console), and taking control of a system console that
another user is currently using (Steal Console)

• generating a nonmaskable interrupt (Generate NMI)

• performing hardware reset (HW Reset), power cycle (Power Cycle), power on (Power
On), and power off (Power Off)

• viewing console activity logs (Show Console Logs)

• optionally creating allow or deny files by a system administrator with root
permission to further restrict a user’s access to particular sites or systems

Note: Generate NMI, HW Reset, and Power Cycle on Origin and Onyx2 systems require
that the system controllers on those systems have default passwords.
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Checking the current security setting and changing it are described in the sections
“Determining Whether IRISconsole Security Is On or Off” and “Setting IRISconsole
Security On or Off” in Chapter 2.

Overview of IRISconsole Operation

The installation and operation of IRISconsole consists of these major steps:

1. Install the multiplexer hardware and cable it to the OCTANE, O2 , or Indy
workstation and the systems you plan to control. See the IRISconsole Multiplexer
Installation Guide for instructions. Additional information is also available in online
man pages.

2. Install the IRISconsole software and configure it: specify administrators and users,
choose the security setting, identify multiplexer port numbers, and prepare for
remote access. See Chapter 2, “Configuring IRISconsole,” for instructions.

3. Specify sites, groups of workstations, servers, or other systems that are to be
administered through IRISconsole. See Chapter 3, “Configuring Sites,” for
instructions.

4. Use the features of the IRISconsole graphical user interface to administer the sites.
See Chapter 4, “Administering Sites,” for details.



7

Chapter 2

2. Configuring IRISconsole

This chapter describes various tasks that you must perform to install and perform the
initial configuration of IRISconsole software. The major sections in this chapter are as
follows:

• “Installing IRISconsole Software” on page 8

• “Adding an IRISconsole Administrator” on page 9

• “Adding an IRISconsole User” on page 10

• “Determining Whether IRISconsole Security Is On or Off” on page 11

• “Setting IRISconsole Security On or Off” on page 11

• “Setting Up Additional Access Control” on page 12

• “Obtaining the Multiplexer SCSI ID Number and Serial Port Connections” on
page 12

• “Determining the Multiplexer Device Name” on page 14

• “Setting Up IRISconsole for Remote Access” on page 15
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Installing IRISconsole Software

To install IRISconsole software, install these subsystems:

eoe.sw.uucp
UUCP software required by IRISconsole software

sgitcl_eoe.sw.base
Tcl toolkit software required by IRISconsole software

sgitcl_eoe.sw.tm
Tcl toolkit software required by IRISconsole software

Note: You must choose the sts.xx.xx subsystems or the el_serial.xx.xx subsystems, or both,
depending upon which multiplexer(s) your site is using.

sts.sw.base
Multiplexer software

sts.man.man
Reference pages for multiplexer software

sts.man.relnotes
Release notes for multiplexer software

IRISconsole.sw.base
IRISconsole base software

IRISconsole.sw.remoteaccess
IRISconsole software for remote access

IRISconsole.sw.tcllink
IRISconsole Tcl software
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IRISconsole.man.man
Reference pages for IRISconsole software

IRISconsole.man.relnotes
IRISconsole release notes

IRISconsole.books.IRISconsole_AG
This guide

IRISconsole.books.MUX_IG
The IRISconsole Multiplexer Installation Guide

Adding an IRISconsole Administrator

To add an IRISconsole administrator, type as root

icpass -add icadmin

The window shown in Figure 2-1 appears.

Figure 2-1 Adding an IRISconsole Administrator

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Adding an IRISconsole User

To add an IRISconsole user, you must be an IRISconsole administrator. Type

icpass -add icuser

The window shown in Figure 2-2 appears.

Figure 2-2 Using the IRISconsole Security Window

After you enter your IRISconsole login and password and click the Apply button, the
window shown in Figure 2-3 appears.

Figure 2-3 Adding an IRISconsole User

Enter the new user’s login and password. Note that they are independent of that user’s
system login and password. Click the Apply button.
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Determining Whether IRISconsole Security Is On or Off

As described in the section “IRISconsole Security” in Chapter 1, IRISconsole can be used
to limit access to the capabilities of IRISconsole. To determine whether IRISconsole
security is on, type

icpass -security get

The software returns off or on.

Setting IRISconsole Security On or Off

To set IRISconsole security on or off, you must be an IRISconsole administrator. To set
IRISconsole security on, type

icpass -security set on

To set IRISconsole security off, type

icpass -security set off

In either case, the security window shown in Figure 2-2 appears. After you enter correct
information, a confirmation window appears with the message

Access Control status changed to ‘ON’

or

Access Control status changed to ‘OFF’
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Setting Up Additional Access Control

IRISconsole uses files to either allow or deny access to particular systems within a site.
These files are icallow and icdeny. They are located in the /usr/IRISconsole/adm directory.
Each entry in these file has the following format:

user_id : site_name : system_name [, system_name ]

The icallow and icdeny files work like the allow and deny functionality of the cron
command. If the entry is in the icallow file, user user_id is allowed access to the system
site_name : system_name. If the entry is in the icdeny file, that user is denied access to
that system. If both the icallow and icdeny files contain entries, then only the entry in the
icallow file is used.

Obtaining the Multiplexer SCSI ID Number and Serial Port Connections

In preparation for installing systems for IRISconsole, you need to obtain a SCSI ID and
port connections numbers by looking at the multiplexer and its cable connections. Follow
these steps:

1. Get the number of the SCSI ID used by the multiplexer. This number was set when
the IRISconsole system was installed and is displayed on the back of the
multiplexer, as shown in Figure 2-4.

Note: If you are installing an EtherLite multiplexer, you do not need to determine
the SCSI ID.
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Figure 2-4 Checking the Multiplexer SCSI ID Number

2. Check the cabling for each system connected to the multiplexer to determine the
multiplexer port to which each system’s Console Connection and Remote System
Control Connection ports are connected.

If you want, create a table such as the example in Table 2-1 as an aid in determining
which serial ports are used for which servers.

Table 2-1 Example Table for Server Multiplexer Port Numbers

Server Hostname
Multiplexer Port Number for
Console Connection

Multiplexer Port Number for Remote
System Control Connection

jupiter 01 02

zeus 03 04

2
6

0 41

57

3

SCSI ID
select switch

1

3

2

4

5

6

7

8

9

10

12
13

14
15

16

11
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Determining the Multiplexer Device Name

Beginning with the IRISconsole 1.3 release, the way special tty devices such as the SCSI
multiplexers (ST-1600, ST-1616, and so on) or EtherLite multiplexers (EL-8 and EL-16) are
created and used has changed. This section describes how to determine the device name
for your multiplexer(s).

SCSI Multiplexers

To determine the name of a SCSI multiplexer, use:

/dev/ttyd{bus}{scsi_id}{port}

where:

• bus is 0, 1, or 2 corresponding to the first, second, or third SCSI multiplexer found.

• scsi_id is the ID of the ST-xxxx number on the SCSI multiplexer.

• port is 0 - 9 or a - v, which corresponds to the port on the SCSI multiplexer numbered
1 through 32 (for example, port 1 = 0, port 11 = a).

Note: On the ST-1616 multiplexer, the ports are numbered 1 through 16, which
correspond to ports 0 - 9 and a - f on the tty device. On the ST-1032 multiplexer, the ports
are numbered 1 through 32, which correspond to ports 0 - 9 and a - v on the tty device.

EtherLite Multiplexers

To calculate the name of an EtherLite multiplexer, use:

/dev/ttydn{elps}{port}

where:

• elps is the EtherLite number from the /etc/els.conf file associated with an IP address.

• port is also 0 - 9 or a - f, which corresponds to port numbers 1 - 16 (for example, port
1 = 0, port 16 = f).
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Setting Up IRISconsole for Remote Access

You can use the command ictelnet, which is a version of telnet adapted for IRISconsole, to
access the IRISconsole text-based menu from another system. Follow these steps to
prepare the IRISconsole system for remote access using ictelnet:

1. To configure a port on the IRISconsole system so that ictelnet communicates directly
to the IRISconsole application, edit the file /etc/services on that system to include the
following line, which specifies the port on which the service is available:

ictelnet 5000/tcp # IRISconsole Remote Access service

For the port number, use any number between 5000 and 5063; the number 5000 is
recommended for the status port.

2. Edit the file /etc/inetd.conf on the IRISconsole system to include this line:

ictelnet stream tcp     nowait   root  /usr/IRISconsole/bin/ictelnetd  ictelnetd
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3. Configuring Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) to set up
a site, configure a site, edit a site configuration, add a system to a site, or delete a site
configuration. The major sections in this chapter are as follows:

• “Starting the IRISconsole Graphical User Interface” on page 17

• “Setting User Preferences” on page 18

• “Adding a Site” on page 20

• “Adding a System to a Site” on page 22

• “Performing Site Operations” on page 26

Starting the IRISconsole Graphical User Interface

The IRISconsole GUI main window enables you to set up a site, configure a site, edit a
site configuration, add a system to a site, or delete a site configuration.

To start the IRISconsole GUI, follow these steps:

Make sure the OCTANE, O2, or Indy workstation, multiplexer, and the Origin,
CHALLENGE, Onyx2, and Onyx systems to be administered are cabled as described in
the IRISconsole Multiplexer Installation Guide and online man pages.

3. Make sure all systems are powered on.

4. The IRISconsole security feature is on by default; to check it or toggle it on or off,
follow instructions in the sections “Determining Whether IRISconsole Security Is
On or Off” “Setting IRISconsole Security On or Off” in Chapter 2.

5. To start the IRISconsole graphical user interface in an IRIX window, enter

ic
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The IRISconsole GUI main window appears, as shown in Figure 3-1.

Figure 3-1 IRISconsole Graphical User Interface Main Window

To exit the IRISconsole GUI, choose Quit from the File menu or press Ctrl+Q.

Setting User Preferences

The Edit menu in the IRISconsole GUI main window lets you turn on or turn off dialog
boxes that ask you to confirm closing IRISconsole, closing a site, deleting a site, deleting
a system, discarding site changes, overwriting a configuration, saving a site
configuration, and saving a system configuration.



Setting User Preferences

19

To set IRISconsole user preferences, follow these steps:

1. From the Edit menu, choose User Preferences.... The Change IRISconsole
Preferences dialog menu appears, as shown in Figure 3-2.

Figure 3-2 Change IRISconsole Preferences Dialog Menu

2. Click the box to the left of each action to turn on (inserts a check mark) or turn off
(deletes the check mark) the dialog box that asks you to confirm the assoicated
actions that appear when you choose User Preferences ... from the Edit menu.

Each menu selection toggles between on or off.



20

Chapter 3: Configuring Sites

Adding a Site

To set up an IRISconsole site and to specify the directories that receive console and alarm
messages, follow these steps:

1. From the Edit menu, choose Add New Site.... The Change IRISconsole Config
dialog box appears, as shown in Figure 3-3.

Figure 3-3 Change IRISconsole Config Dialog Box

2. In the Site field, type a name for the site.

3. In the Console Logs Directory field, type the pathname of the directory that will
receive console messages.

4. In the Alarm Logs Directory field, type the pathname of the directory that will
receive alarm messages.

5. Click the Apply button.

The name of the configuration file as defined in the
/var/IRISconsole/2.0/.IC/<site_name>/<system_names> directory appears in the
Config field. The system_names are the configuration files which contain the
configuration information for all the systems in a particular site defined by
site_name.

6. To save the new site configuration, choose Save IRISconsole Config from the File
menu in the main IRISconsole window.

Note: If you do not save the site configuration at this time, you can not save system
configurations later.
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7. To add another site, edit the entry in the Site field or click the Reset button to clear
the field. After you click the Apply button, the name of the new configuration file
appears automatically in the Config field. Figure 3-4 shows a site named
CM_cluster. Save the new site configuration as in step 6.

Figure 3-4 IRISconsole Graphical User Interface Main Window with Cluster Icon

8. When you are finished adding systems to the site, close the site window by clicking
the Close button.

9. To save the configuration, choose Save IRISconsole Config from the File menu. The
site_name directories and system_name configuration files are saved to the
IRISconsole directory /var/IRISconsole/2.0/.IC. Click the Close button to exit the
Change IRISconsole Config dialog box.
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Adding a System to a Site

To add a system to a site, follow these steps:

1. In the IRISconsole main window, double-click the site to which you want to add a
system or select the system and choose Open Site... from the Operations menu. The
site window opens, as shown in Figure 3-5.

Figure 3-5 Site Window
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2. In the site window, choose Add New System... from the Edit menu. If IRISconsole
security is on, you are prompted for your password.

After you enter your password, the Change Site Config dialog box appears, as
shown in Figure 3-6.

Figure 3-6 Change Site Config Dialog Box

3. In the System Name field, type the hostname of the system you want to add to this
site.

4. From the System Type option menu, choose the type of system you want to add to
this site. The choices are Origin200, Origin2000, CHALLENGE, Onyx2, and Onyx
systems.
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5. From the Console Connection option menu, choose the type of multiplexer for this
system and the Console port number. A number of multiplexers may be listed, such
as ST-1600, ST-1616, ST-1620, ST-1032, EL-8, or EL-16. Use the Console Port# and
Remote System Control Port# entries you made in the table similar to Table 2-1 to
choose the appropriate multiplexer port numbers for each respective cable
connection. You can have different multiplexers for each port; one for the console
and another, if present and desired, for the remote system controller.

6. From the Remote SystCtrl Connectionoption menu, choose the type of multiplexer
for this system and the Remote System Control Connection port number.

7. In the Login field, enter the login under which all operations requiring access to the
system via the network can be performed. This login is the one used in the
command

rsh login@system /usr/etc/sysctlrd -r

Note: The IRISconsole security login is separate from this system login; IRISconsole
security is explained in “IRISconsole Security” in Chapter 1.

8. From the Baud Rate option menu, choose the baud rate at which this system sends
data to IRISconsole; the default is 9600. If you enter a different baud rate, be sure
that the system has been configured for that rate.

9. Click the box at Log Console Activity to File if you want console activity logged to a
file in the /var/IRISconsole/logs/console_logs directory that has the format
systemname.<timestamp>.log. The format of this filename cannot be changed.

Note: To view a log of a system’s console activity (Spy Console button or command)
or to view console activity logs (View Console Logs button or command), this box must
be checked when the system is added to a site.

The console logs and alarm log directories may be changed in the Site Configuration
dialog box.

10. Click the box at Default System Controller Password if the system controller
password has the default value. This box applies only to Origin and Onyx2 systems.
If the system controller doesn’t have the default password, the operations Generate
NMI, HW Reset, and Power Cycle are not available; Connect SYSCTLR must be used
instead (see the section “Viewing Site Characteristics” in Chapter 4).

11. Click the box at FailSafe Controls SysCtrl Port if this system control port is to be
controlled by Silicon Graphics IRIS FailSafe 1.2 or FailSafe 2.0 high-availability
software.
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Note: To use this feature you must be familiar with IRIS FailSafe software. For
information about IRIS FailSafe 1.2 or FailSafe 2.0, see the IRIS FailSafe
Administrator’s Guide, 007-3109-003, or IRIS FailSafe 2.0 Administrator’s Guide,
007-3901-001, respectively.

When a system control port is being controlled by FailSafe software and you try to
reset the system after changing the system configuration, you see a warning dialog
box instructing you to use the appropriate FailSafe command as shown in
Figure 3-7.

Figure 3-7 FailSafe Warning Dialog Box

12. Click the box at Partitioned System if the system you are adding to the site is a
partitioned system. A system partition is represented by a unique icon as shown in
Figure 3-8.

13. When you are satisfied with the settings for this system, click the Apply button to
add this system to the site.

14. To save the configuration, choose Save Site Config from the site window File menu.

15. To add another system to the site, edit the entries in the fields of the Change Site
Config dialog box, or click the Reset button to clear all entries and begin entering
again. Follow instructions in steps 3 through 14 for the new system. An IRISconsole
site with four systems is shown in Figure 3-8.
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Figure 3-8 IRISconsole Site With Four Systems

16. When you are finished adding systems to the site, close the Change Site Config
dialog box by clicking the Close button.

Performing Site Operations

The bottom of the IRISconsole main window, as shown in Figure 3-9, has four buttons
that allow you to perform the following operations:

• open a site

• shut down all systems in a site

• set system alarms

• show the system logs for all systems in a site
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Alternatively, you can choose these operations in the Operations menu on the
IRISconsole main window, as shows in Figure 3-9.

Figure 3-9 IRISconsole Main Window Operations Menu

These operations are described in greater detail in chapter 4, “Administering Sites.”
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4. Administering Sites

This chapter explains how to use the IRISconsole graphical user interface (GUI) and
IRISconsole commands to administer IRISconsole and the servers and other devices in
sites that it controls. The major sections in this chapter are as follows:

• “Administering IRISconsole Users and Administrators” on page 30

• “Connecting to a Remote IRISconsole Workstation” on page 32

• “Viewing Site Characteristics” on page 35

• “Performing Operations on Attached Systems” on page 38

• “Using the Availability Monitor Report” on page 40

• “Displaying the System Log” on page 41

• “Displaying the System Logs for All Systems in a Site” on page 41

• “Storing System Log Information” on page 42

• “Displaying the Hardware Inventory of a System” on page 43

• “Displaying Hardware Status Information” on page 43

• “Using Alarms” on page 48

• “Using Graph Files” on page 50

• “Renaming or Deleting a Site” on page 52

• “Modifying or Deleting a System” on page 53
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Administering IRISconsole Users and Administrators

The icpass command is used to list administrators and users, change their passwords, and
delete them. Performing these tasks is described in the following subsections. (Adding
administrators and users is described in the sections “Adding an IRISconsole
Administrator” and “Adding an IRISconsole User” in Chapter 2.)

Displaying a List of IRISconsole Administrators or Users

To display a list of IRISconsole administrators, type

icpass -list icadmin

To display a list of IRISconsole users, type

icpass -list icuser

In each case, IRISconsole prints the path of the password file.

Changing the Administrator’s or User’s Password

To change an IRISconsole administrator’s or user’s password, type

icpass -change icuser

or

icpass -change icadmin

The window shown in Figure 4-1 appears.
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Figure 4-1 Changing an IRISconsole Password

Enter the login for the user whose password you want to change. Enter the user’s old
password and new password, and click the Apply button.

Deleting an Administrator or User

To delete an IRISconsole administrator or user, you must be an IRISconsole
administrator. Type

icpass -delete icadmin icadminlogin

or

icpass -delete icuser icuserlogin

The security window shown in Figure 2-2 appears. After you enter correct information,
a confirmation window appears with the message

Entry deleted from password database
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Connecting to a Remote IRISconsole Workstation

You can use the command ictelnet to access the IRISconsole text-based menu from
another system. Follow these steps:

1. If you haven’t already done so, configure the IRISconsole system for remote access.
Follow the instructions in the section “Setting Up IRISconsole for Remote Access” in
Chapter 2.

2. To use ictelnet from any system, type

ictelnet consolehostname port

The port number should be the port number value for ictelnet services in the
/etc/services file determined in step 1 of “Setting Up IRISconsole for Remote Access”
in Chapter 2 of this manual.

Note: The recommended port number is 5000.

The software prompts for your IRISconsole login and password.

3. Enter your IRISconsole login and password as they were entered with icpass -add
icuser or icpass -add icadmin; see “Adding an IRISconsole Administrator” in
Chapter 2 for details.

After a few lines of response, the available IRISconsole sites are listed, for example:

Main Menu:
Available Sites
---------------
1. eng1a
2. eng1b
3. eng1c

Enter choice (1 - 3) or ’q’ to Quit:

If a network connection from the remote host you are using to the IRISconsole
system is not available, you have two choices:

• log in to the IRISconsole system via modem and use ictelnet from there

• if you have a (modem) SLIP or PPP connection, you can run the IRISconsole
GUI remotely
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4. Enter the number for the site to which you want to connect.

Text like the following appears:

     Site ’eng1a’:
     Available Systems
     -----------------
     1. eng1a
     2. eng1b
     3. eng1c

     Enter choice (1 - 3) or ’..’ for Main Menu:

If an entry beneath the Available Systems heading is a partitioned array,
“(Partitioned System)” is appended to the system name. If this system is chosen,
another submenu is displayed, and a list of partition names appears, for example:

System: elements
Available Partitions
---------------------
1.  mercury
2.  argonne

Enter choice (1 - 2) or ‘ ..’ for Main Menu:

5. Enter the number for the system to which you want to connect.

The Available Operations menu appears, for example:

        System ’eng1a’:
        Available Operations
        --------------------
        1. Connect to Console
        2. Hardware Reset
        3. Generate NMI
        4. Power Cycle

5. Power On
6. Power Off
7. Steal Occupied Console Line
8. Connect to System Controller
9. Start Service Tool

     Enter choice (1 - 5) or ’..’ for Systems Menu:

Note: HW Reset, Generate NMI, and Power Cycle on an Origin or Onyx2 system
require that the system controller have the default password.
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6. Enter the number for the operation you want to perform.

The following message appears:

     This operation is protected.
     Please enter your IRISconsole login and password.

     IRISconsole Login:

7. Enter your IRISconsole login and password at the prompt.

Status and other information like the following appears:

------Connected Port=/dev/ttyd043 ------

  9600 BAUD 8 NONE 1 SWFC=ON  HWFC=OFF
CAR=ON  DTR=ON  RTS=ON  CTS=ON  DSR=ON
Type ~? for Help, ~X to Exit.
Connection Ready.

8. Use the tilde commands ((+-)Baud Csize Dtr Framing Hwfc Info breaK Modem

Oflush Parity Rts Swfc eXit) to change settings; you need not press <Enter>.

For example, ~S (note that this letter is uppercase) toggles software flow control and
displays a message similar to:

  9600 BAUD 8 NONE 1 SWFC=OFF HWFC=OFF
                     ^^^^^^^^

9. To exit ictelnet, type ~X.

This command returns you to the Available Operations menu for the system that
was described in step 5 of this procedure.

10. From the Available Operations menu, type .. to exit to the Systems Menu, type ..
to exit to the Main Menu, then type q to exit to the IRIX prompt.
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Viewing Site Characteristics

To see characteristics for a site, double-click its name in the scrolling list of sites in the
IRISconsole main window. Figure 4-2 shows an example main window.

Figure 4-2 Example IRISconsole Main Window

Alternatively, you can select a site and then choose Open Site from the IRISconsole main
window Operations menu. Figure 4-3 shows an example site window.
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Figure 4-3 Example IRISconsole Site Window

To get a console for a system that is part of a partitioned system, you must choose a
partition from the list that appears when you choose Select System Partition... from the
Edit menu as shown in Figure 4-4. If you attempt to choose a system by double-clicking
on the partitioned system icon, you see the error message shown in Figure 4-5.
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Figure 4-4 Selecting a Partitioned System

Figure 4-5 Select Partition Warning Dialog Box



38

Chapter 4: Administering Sites

Performing Operations on Attached Systems

You can use the buttons in the site window (see Figure 4-3) for system administration
tasks. All but the HW Status button display a window in which you type your
IRISconsole login and password as it was entered in the IRISconsole security facility; see
“IRISconsole Security” in Chapter 1. The buttons are as follows:

Get Console To access and display a system’s console window, select the system and
click the Get Console button. The console window appears on the
workstation screen.

Connect SYSCTRL
To access and display a system’s system controller port window, select
the system and click the Connect SYSCTRL button. The system controller
window appears on the workstation screen. This is used primarily on
Origin and Onyx2 systems.

Steal Console To take control of a system console that another user is currently using,
select the system and click the Steal Console button. The console window
appears on the workstation screen. The original user sees the message
IRISconsole DINC closing...; that user’s session is killed.

Spy Console To display a window showing console activity of a system in progress,
select the system and click the Spy Console button. In order to view this
activity, the Log Console Activity to File option must have been checked
when the system is added to a site, as explained in step 9 in “Adding a
System to a Site” in Chapter 3.

Show Console Logs
To view console logs (stored in /var/IRISconsole/logs/console_logs/), select
the system and click the Show Console Logs button. In order for these logs
to be written, an IRISconsole user must be connected via the Get Console
command and the system must have been configured with the Log
Console Activity to File option checked, as explained in step 9 in
“Adding a System to a Site” in Chapter 3.

HW Status To display graphs of system activity, click the HW Status button. The
Hardware Status Monitor appears; this feature is explained in detail in
the section “Displaying Hardware Status Information” later in this
chapter. This feature requires a network connection between the
OCTANE, O2, or Indy host and the target system.
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Generate NMI
To generate a non-maskable interrupt (forcing a panic in the operating
system), click the Generate NMI button.

Note: Generate NMI on an Origin or Onyx2 system requires that
system’s system controller have the default password.

Start Serv Tool
To start the Service Tool, a tool intended for use by Silicon Graphics field
personnel, select a system and click the Start Serv Tool button. A shell
window appears.

HW Reset To reset a system in a site (hardware reset), select the system and click
the HW Reset button. A confirmation message appears.

Note: HW Reset on an Origin or Onyx2 system requires that system’s
system controller have the default password.

Power Off To power off a system, select the system and click the Power Off button.

Power Cycle To power-cycle a system, or to power on a system that has been turned
off, select the system and click the Power Cycle button.

In the case of a power cycle, the system controller removes the power
enable control signals, waits five seconds, and restores power. Boot
arbitration is started after power is reapplied.

Note: All power functions (Power Cycle, Power On, and Power Off) on an
Origin or Onyx2 system requirebdog5ten

that system’s system controller have the default password.

Power On To power on a system, select the system and click the Power On button.

For each of these tasks, you can also choose the corresponding command from the
Operations menu.

When you configure a system within a site, you have the option of specifying one or both
port connections, the console and/or the remote system control port, described in
“Adding a System to a Site” on page 22. Once a system is configured and you select it by
double-clicking the appropriate icon on the IRISconsole site window, only those
operation buttons and corresponding pulldown menu selections that can be used are
activated.

For example, if only the console port is configured, then only the Get Console, Steal
Console, Spy Console, Show Console Logs, and HW Status buttons are activated for use.
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The following operation buttons require a Console connection:

• Get Console

• Steal Console

The following operation buttons require a Remote System Controller connection:

• Connect SYSCTRL

• Generate NMI

• Start Serv Tool

• HW Reset

• Power Off

• Power Cycle

• Power On

The following operation button requires a network connection for rsh:

• HW Status

The following operation buttons do not require any connection:

• Spy Console

• Show Console Logs

Using the Availability Monitor Report

The IRISconsole Availmon report gives a snapshot of availability information on a
system. It is a condensation of the information in /var/adm/avail/availlog, displayed in a
format similar to that of /var/adm/avail/amreport.

To display the Availmon report, follow these steps:

1. Make sure that availmon is installed and active on the Origin, CHALLENGE, Onyx2,
and Onyx systems you wish to access (use /etc/chkconfig).

2. In the site window, select the system for which you want a report.

3. Choose Availmon Report... from the Monitor menu. A window like the one in
Figure 4-6 appears.
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Figure 4-6 Example Availability Monitor Report

Displaying the System Log

To display the SYSLOG for a system, select the system in the site window. Choose Show
Syslog... from the Monitor menu.

To update the SYSLOG display, close the syslog window and choose Show Syslog...
again.

To display the SYSLOG for all of the systems in a site, choose All Systems

Displaying the System Logs for All Systems in a Site

You can use the Show SYSLOGs button on the IRISconsole GUI main window to view the
system log messages for all systems in a site using the System Log Viewer window as
shown in Figure 4-7.
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Figure 4-7 System Long Viewer Window

Storing System Log Information

You can store the SYSLOG entries for all systems in a site in the same log file on the
system running IRISconsole 2.0. To do this, add a line similar to the following example
in each /etc/syslogd.conf file for each system:

*.crit;*.notice;*.info;*.debug  @cmindy.cray.com

where @cmindy.cray.com is the name of the system running IRISconsole 2.0. This line
instructs the syslogd daemon to send all critical, notice, information, and debug messages
to @cmindy.cray.com.
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Displaying the Hardware Inventory of a System

To display a hardware inventory of an attached system, select the system in the site
window and click Hardware Inventory... from the Monitor menu. The output of hinv for
that system appears in a window.

Displaying Hardware Status Information

Note: Hardware status information is not available for Origin or Onyx2 systems. This
section and its subsections do not apply to Origin or Onyx2 systems.

To display hardware operating information on a CHALLENGE or Onyx system in a site,
follow these steps:

1. In the IRISconsole main window, double-click on the site containing the system
whose hardware operating information you want to check. The site window
appears.

2. In the Systems scrolling list of the site window, select the system for which you want
information.

3. Click the HW Status button. The IRISconsole Hardware Status Monitor appears, as
shown in Figure 4-8.
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Figure 4-8 Example IRISconsole Hardware Status Monitor

The subsections below explain how to customize the Hardware Status Monitor display,
change the point and line styles for graphs, and use graph control panels for specific
graphs.

Customizing the Hardware Status Monitor Display

To change the height of a graph in the IRISconsole Hardware Status Monitor, put the
mouse cursor on one of the two sashes (small square at the extreme right between the
graphs) and drag it down or up; the relative heights of the graphs above and below it
change.

To zoom an area of the display, select the graph you want to zoom; holding down the
Ctrl key and pressing the middle mouse button, move the mouse. Press r to reset the
display.
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You can further customize the display using options from the Hardware Status Monitor
View menu. Figure 4-9 shows the View menu.

Figure 4-9 View Menu

Finally, you can use the Global Controls dialog box to customize the graph data. Choose
Global Controls...from the Options menu; Figure 4-10 shows this dialog box.

Figure 4-10 Global Controls Dialog Box
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Changing Point or Line Styles for Graphs

To change the point or line style in a graph display, follow these steps:

Note: Style changes apply onscreen and for printing only; point and font style changes
are not saved when the graph is saved to a file.

1. From the Selected menu, choose Styles... or click the Styles button in the Graph
Control dialog box. Figure 4-11 shows the Graph Style dialog box.

Figure 4-11 Graph Style Dialog Box

2. In the Hardware Status Monitor, click the left mouse button on the graph whose
style you want to change. The graph background turns yellow.
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3. Put the mouse cursor on the line whose style you want to change and click the right
mouse button.

Note: To facilitate selecting a line, zoom the display by holding down the Ctrl key,
pressing the middle mouse button, and moving the mouse. To reset the display,
type r.

4. In the Graph Style dialog box, select the point or line style you want and click the
Apply button to save the setting.

5. When you are satisfied with the settings, click the Close button to exit the Graph
Style dialog box.

Using Graph Control Panels for Specific Graphs

A graph control panel is associated with each graph. To display the control panel for a
graph, follow these steps:

1. In the Hardware Status Monitor, select the graph for which you want to display a
control panel. The graph background turns yellow.

2. From the Selected menu, choose Graph Controls.... Figure 4-12 shows the graph
control panel for blower speed(s).

Figure 4-12 Graph Control Panel for Blower Speed

Set data density for the selected graph

Set high and low threshold values for an alarm

Determine whether the selected graph displays live data

Display Global Controls dialog box
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Use features of this panel to

• set an alarm threshold, as described in “Using Alarms,” later in this chapter

• set actions to be performed if the threshold is exceeded, as described in “Using
Alarms,” later in this chapter

• clear an alarm

• change the point and line style of the graphs, as described in “Changing Point or
Line Styles for Graphs,” earlier in this chapter

• print the graphs, as described in “Saving Graph Data to a File,” later in this chapter

• save the graphs as graphs or PostScript files, as described in “Printing a Graph,”
later in this chapter

Using Alarms

Note: Alarms are not available for Origin or Onyx2 systems. This section and its
subsections do not apply to Origin or Onyx2 systems.

You can set a threshold value for a hardware operating parameter, such as blower speed.
When the value is exceeded, the graph that maps it changes color to alert you that the
threshold has been exceeded and its contents are saved to a file. You can also set
IRISconsole to perform any of the following actions when the threshold is exceeded:

• cause a beep or tone to be sounded

• enter a message in an alarms log file in the directory /var/IRISconsole/logs; the default
filename is alarms.log

• start a notify script

For example, you can set the operating temperature threshold for a CHALLENGE XL in
a site to 37, so that when the system internal temperature exceeds 37 degrees C, the alarm
is triggered.

This section explains

• setting a threshold for an alarm

• clearing an alarm

• viewing an alarm graph file

• using a notify script
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Setting a Threshold for an Alarm

To set a threshold, follow these steps:

1. Select the graph for which you want to set an alarm threshold. The graph
background turns yellow.

2. From the Selected menu, choose Graph Controls.... The Graph Control Panel
appears; Figure 4-13 shows the panel for the Temperature graph.

Figure 4-13 Graph Control Panel for Temperature

3. If desired, change the data density (number of points) of the data being sampled.

4. Select the high and low alarm threshold values you want from the choices in the
High and Low fields.

5. If desired, select one or more alarm actions in the Global Controls window.

When the threshold value is reached or exceeded, the graph display turns hot pink when
unselected (bright red when selected).

Clearing an Alarm

To clear an alarm, select the graph whose alarm you want to clear and click the Clear
Alarm button in the Graph Control panel, or choose Clear Alarm from the Selected menu.
To clear all alarms, choose Clear All Alarms from the Options menu.
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Viewing an Alarm Graph File

When a threshold is exceeded, the graph for which the alarm is set is automatically saved
to a file in the directory /var/IRISconsole/logs/alarms. The filename has the format
graphname.<timestamp>.xrt; for example, voltage.951231.1144.0.xrt.

You can view alarm graph files by choosing Display Saved Graph... from the IRISconsole
Hardware Status Monitor File menu; see “Displaying a Graph File,” later in this chapter.

Using a Notify Script

An option in the Global Controls window enables IRISconsole to run a script—
/var/IRISconsole/adm/scripts/icnotify.tclX—when an alarm threshold is exceeded. This
script, which was written in tclX (extended tcl), is self-documenting.

To edit this script, choose Edit Operator Notify Script from the main window Options
window. You must be root to edit this script.

For example, to cause an alarm threshold to send an e-mail message to a specified user,
enter e-mail address(es) in the curly braces in the line

set OPERATORS { }

You can edit icnotify.tclX to include other scripts.

Using Graph Files

Note: Graph files are not available for Origin or Onyx2 systems. This section and its
subsections do not apply to Origin or Onyx2 systems.

You can save, display, and print graph data for CHALLENGE and Onyx systems in files
in either PostScript or image form. The subsections below describe how to perform these
operations.
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Saving Graph Data to a File

You can save a graph to a PostScript file or image file to send to service personnel, or to
compare with other graph data saved to files.

To save a graph to a PostScript file, click the Save As PS... button in the Graph Control
panel. Enter a filename and click the Save button to save the file and exit the dialog box.

To save a graph to an image file, follow these steps:

1. Freeze the data by clicking the Live Data Feed check box off in the Graph Control
panel (see Figure 4-12 or Figure 4-13). The scroll bars under the graphs are
activated.

2. Click the Save As Graph button in the Graph Control panel. A file selection dialog
box appears, as shown in Figure 4-14.

Figure 4-14 Saving a Graph File

If desired, click the Filter button to display a dialog box in which you can exclude
filename patterns to restrict the filenames displayed.

3. Enter a filename for the graph file in the Selection field.

4. Click the Save button to save the file and exit the dialog box.
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Displaying a Graph File

You can display the saved graph in IRISconsole by choosing Display Saved Graph... from
the IRISconsole Hardware Status Monitor File menu. A dialog box similar to that shown
in Figure 4-14 appears, in which you select the file to display. Files saved as graphs
appear when they are selected.

To display files saved as PostScript files, use your PostScript viewer.

Printing a Graph

You can print a PostScript graph file just as you would print any other PostScript file.

You can also print a graph as it is displayed in the Hardware Status Monitor. Follow these
steps:

1. In the Hardware Status Monitor, select the graph you want.

2. If desired, change the dimensions of the graph by moving a sash (small square at the
extreme right between the graphs).

3. If desired, select an area of the display by holding down the Ctrl key and pressing
the left mouse button; zoom the selection by moving the middle mouse button.
(Press r to reset the display.)

4. When the screen displays the graph as you want it to be printed, click the Print
button. In the Print dialog box, choose the print options you want.

Renaming or Deleting a Site

You can rename or delete a site using options from the IRISconsole main window Edit
menu.
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Modifying or Deleting a System

If your hardware configuration changes, choose Modify System Config... from the site
window Edit menu to change the parameters for a system in a site.

To delete a system from a site, select it in the site window and choose Delete Selected
System from the Edit menu.

Note: The Save As... option in the site window Edit menu was removed in the
IRISconsole 1.3 release.
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A. Error Messages and Warning Messages

This appendix lists error messages that can appear during operation of IRISconsole. It
interprets each error message and suggests solutions. The messages are listed in
alphabetical order.

<name> is a directory

You selected a directory to save into, when a file was expected.

A site edit session is in progress.
Finish that before opening.

It is not possible to open a site while its configuration information is
being edited. Finish the editing first.

Cannot create directory <name>

Cannot create directory; permissions on /var/IRISconsole should be
writable by the user.

Cannot edit multiple configurations.

You have selected more than one site or system. Select one site or system
at a time to edit.

Caution: Baud rate of a Challenge machine is typically 9600.
Make sure that it is configured to handle this rate.

A legal value other than 9600 was entered in the Baud Rate: field of the
Change Site Config dialog box. Although the baud rate can range from
300 to 115,200, any rate other than the default rate of 9600 needs
configuration changes in the managed server to accept that rate. Note
that this messages is a warning and not an error message.
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Appendix A: Error Messages and Warning Messages

Couldn’t find an ST-1600 attached to SCSI bus.

IRISconsole couldn’t detect any multiplexers that should have been
attached to a SCSI port on the back of the OCTANE, O2, or Indy
workstation. Follow these steps:

1. Check the SCSI target ID on the back of the multiplexer; make sure
that it does not conflict with any other external devices that are
attached. Do not use the settings 0 or 1.

2. Check the connections of the SCSI cable between the multiplexer
and the OCTANE, O2, or Indy SCSI port. Use the High Density
SCSI-2.cable supplied with the multiplexer or another cable
meeting specifications outlined in the Technical Specifications
chapter of the IRISconsole Multiplexer Installation Guide.

3. After checking and, if necessary, reseating connectors, ask
IRISconsole to rescan by selecting “Show SCSI Bus Attachments” in
the Options menu of the main IRISconsole window. This action
displays the SCSI IDs of all multiplexers that IRISconsole finds.

Error in getting Hardware Inventory.
Either the target system could not be reached, or
it’s refusing service to the Login ’<login>’

You tried to run hinv on a system in a site. Either the target system could
not be reached, or it is refusing service to your login. Follow these steps:

1. Check the network connection with the target system (ping or
another command as appropriate).

2. Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

3. Make sure that the login you entered has permission to perform a
remote operation by typing

rsh login@system hinv

If necessary, correct the login (or get its permissions changed) and
retry the command above.
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Error in ST-1600 software installation
Couldn’t find /sbin/cdscanbus

The multiplexer software subsystem has not been installed. Install it
from the distribution CD.

Failed to create config file

You have attempted to create a new site. Check the permissions on
/var/IRISconsole to see if it is writable for your login.

Failed to fetch /var/adm/SYSLOG: <reason>

The system has probably refused service to your login. Follow these
steps:

1. Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

2. Make sure that the login you entered has permission to perform the
operation by typing

rsh login@system tail /var/adm/SYSLOG

If necessary, correct the login (or get its permissions changed) and
retry the command above.

Failed to write to file

Your attempt to save the configuration file failed. Check permissions on
/var/IRISconsole/.IC/site/systemname to see if it is writable for your login.

Invalid field value <value>

The value you entered in this field of the Change Site Config dialog box
is invalid; try again.

Invalid System Console port number
Invalid Remote System Control port number

Multiplexer port numbers may range only from decimal 1 to 32.

Must select a site.
Must select a system.
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An attempt was made to perform an operation on a site or system
without actually selecting it. Single-click on the desired site or system
first and try the action again.

No Availability Monitor information to report.
Either <system> doesn’t have an ‘availmon’ running, or
it’s refusing service to the Login <login>

Either the currently selected doesn’t have an availmon running, or it is
refusing service to your login. Check the login you have entered for that
system: select the system and choose “Modify System Config” in the
Edit menu of the site window. If necessary, correct the login (or get its
permissions changed) and retry the operation.

The System Availability Monitoring Facility (availmon) is included in the
eoe2.sw subsystem and must be installed on the Origin, CHALLENGE,
or Onyx server. After it is installed, activate it by typing

/etc/chkconfig avail on

No icons may be dropped into this panel.

This version of IRISconsole does not support drag and drop behaviors
on icons. The icon(s) dropped will automatically be repositioned at their
original locations.
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No Remote System Control information to report.
Either <system> doesn’t have a ‘sysctlrd’ running, or
it’s refusing service to the Login <login>

Either the currently selected system doesn’t have a sysctlrd running, or
it is refusing service to your login.

If the connected system is a CHALLENGE S, you cannot perform the
action you tried; this type of server has no system controller, which is
required for this action.

For other connected systems, follow these steps:

1. Check the login you have entered for that system: select the system
and choose “Modify System Config” in the Edit menu of the site
window.

2. Make sure that the login you entered has permission to perform the
operation by typing

rsh login@system /usr/etc/sysctlrd -p

If necessary, correct the login (or get its permissions changed) and
retry the command above.

Nothing selected.

You have specified an action for which a site or system must be selected.
Select the item and try the action again.

Null input values aren’t allowed.
Spaces not allowed in fields.

Enter a valid value in the field.

Null site name.
Null system name.

An attempt was made to create a site or system with a “null” name.
Names must have at least one character and may not contain spaces.

Please close following site(s) before deleting

You attempted to delete a set of sites when a subset of it was still open.
Close the site(s) and try the action again.
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Port number must be between 1 and 16.

Multiplexer port numbers may range only from decimal 1 to 16.

Rename not allowed when site is open.

An attempt was made to rename a site that is already open. Close the site
first.

SCSI ID must be between 1 and 7.

Inspect the back of the multiplexer for the SCSI target ID used. To verify
that the multiplexer is installed properly, select “Show SCSI Bus
Attachments” in the Options menu of the main IRISconsole window and
check the SCSI ID displayed in the dialog box.

Site is already open.

An attempt was made to open a site that is already open. The site
window appears at the top of the stack of windows.

Site name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a site that exists already. Create a unique
site with a new name. To change the configuration of an existing site,
select it first.

Spaces not allowed in fields.

Enter a valid value in the field.

System name already exists.
Select it, then “Edit” its configuration.

An attempt was made to create a system that exists already. Create a
unique system with a new name. To change the configuration of an
existing system, select it first.
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/usr/sbin/sysmon not installed.

sysmon.sw, included in the base IRIX release, is a GUI-based tool for
analyzing system logs. Install this system from the IRIX 6.2 (Indy) or
IRIX 6.3 (O2) CD for this feature to function.

You must have eoe.sw.uucp installed.

IRISconsole uses uucp-style locking on device nodes. Install this
subsystem from the IRIX 6.2 (Indy) or IRIX 6.3 (O2) CD.

System selected is not partitioned.

The system was defined to be a partitioned system but upon querying
the system no partitions were found.
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and IRISconsole security login,  24
security,  9, 10

M

muliplexer,  1
multiplexer

port number,  13
problem,  56
SCSI ID

checking,  12
software installation problem,  57

N
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login and password,  34
setting up,  15

Remote System Control port,  1
and multiplexer port number,  13
invalid number,  57
problem getting information,  59



65

Index

S

saving graph as file,  51
security,  5, 11

adding administrator,  9
adding user,  10
changing password,  30-31
deleting administrator or user,  31
determining if off or on,  11
login,  9, 10

and remote access,  34
password,  9, 10

and remote access,  34
setting on or off,  11
viewing list,  30

Show Console Logs,  38
and security,  5

site
adding,  20
adding systems to,  22-??
administering,  29-53
configuring,  17-??

entering changes,  53
defined,  4

Spy Console,  38
and security,  5

ST-1600,  xiii

Start Service Tool,  39
Steal Console,  38

and security,  5
sylodg

Remote logging,  42
system

adding to site,  22-??
administration,  38-39

see alsoIRISconsole, monitoring attached systems
System Console port,  1
system log (syslog),  41

problems,  57

U

/usr/sbin/sysmon problem,  61

V

/var/IRISconsole/adm/scripts/icnotify.tclX,  50
/var/IRISconsole and config file,  57
/var/IRISconsole/logs/,  48
viewing a partitioned system,  36
View menu,  45







Tell Us About This Manual

As a user of Silicon Graphics products, you can help us to better understand your needs
and to improve the quality of our documentation.

Any information that you provide will be useful. Here is a list of suggested topics:

• General impression of the document

• Omission of material that you expected to find

• Technical errors

• Relevance of the material to the job you had to do

• Quality of the printing and binding

Please send the title and part number of the document with your comments. The part
number for this document is 007-2872-004.

Thank you!

Three Ways to Reach Us

• To send your comments by electronic mail, use either of these addresses:

– On the Internet: techpubs@sgi.com

– For UUCP mail (through any backbone site): [your_site]!sgi!techpubs

• To fax your comments (or annotated copies of manual pages), use this
fax number: 650-932-0801

• To send your comments by traditional mail, use this address:

Technical Publications
Silicon Graphics, Inc.
2011 North Shoreline Boulevard, M/S 535
Mountain View, California  94043-1389


